
Q .1Q .1 Jus t ice M ahadev G ovind Ranade was  ins trumental  in es tabl is hing whic h of the fo l lowing organis at ions?Jus t ice M ahadev G ovind Ranade was  ins trumental  in es tabl is hing whic h of the fo l lowing organis at ions?
A nsA ns 1. Mohammedan Literary Society

2. Poona Sarvajanik Sabha
3. Brahmo Samaj
4. Arya Samaj

Q .2Q .2 Q utbuddin A ibak  was  a  Turk is h s lave of whic h of the fo l lowing k ings?Q utbuddin A ibak  was  a  Turk is h s lave of whic h of the fo l lowing k ings?
A nsA ns 1. Shamsuddin Iltutmish

2. Ghiyasuddin Balban
3. Mahmud Ghazni
4. Muhammad Ghori

Q .3Q .3 A cc ording to  the 2 0 1 1  C ens us  of Ind ia ,  whic h of the fo l lowing Union Terr itor ies  has  the lowes t  populat ion dens ity ?A cc ording to  the 2 0 1 1  C ens us  of Ind ia ,  whic h of the fo l lowing Union Terr itor ies  has  the lowes t  populat ion dens ity ?
A nsA ns 1. Ladakh

2. Andaman and Nicobar
3. Dadra and Nagar Haveli
4. Daman and Diu

Q .4Q .4 Whic h organis at ion has  partnered with the Inter- A meric an Development Bank  to  enhance the c o l lec t ion andWhic h organis at ion has  partnered with the Inter- A meric an Development Bank  to  enhance the c o l lec t ion and
s har ing of c r it ic al  c l imate and weather  data in L at in A meric a and the C ar ibbean?s har ing of c r it ic al  c l imate and weather  data in L at in A meric a and the C ar ibbean?

A nsA ns 1. United Nations Institute for Training and Research
2. United Nations Development Programme
3. World Health Organization
4. World Bank

Q . 5Q . 5 In northern India ,  a  break  in the mons oon is  often due to  the lac k  of what a long the mons oon trough or  ITC Z?In northern India ,  a  break  in the mons oon is  often due to  the lac k  of what a long the mons oon trough or  ITC Z?
A nsA ns 1. Formation of clouds

2. Frequent rain-bearing storms
3. Temperature variation
4. Increase in relative humidity

Q .6Q .6 The 2 0 1 1  C ens us  d iv ided India's  work ing populat ion into  four  major  c ategor ies .  Whic h of the fo l lowing is  one ofThe 2 0 1 1  C ens us  d iv ided India's  work ing populat ion into  four  major  c ategor ies .  Whic h of the fo l lowing is  one of
thes e c ategor ies?thes e c ategor ies?

A nsA ns 1. Cultivators
2. Unemployed population
3. People working abroad
4. Migrant workers
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Q .7Q .7 L ater ite s o i l  is  s uitable for  whic h group of c rops  in Ind ia  from among the fo l lowing?L ater ite s o i l  is  s uitable for  whic h group of c rops  in Ind ia  from among the fo l lowing?
A nsA ns 1. Sugarcane and pulses

2. Rice and wheat
3. Tea and cashewnut
4. Mustard and rice

Q .8Q .8 Where was  the 3 7Where was  the 3 7t ht h  ed it ion of the National  G ames  held? edit ion of the National  G ames  held?

A nsA ns 1. New Delhi
2. Rajasthan
3. Goa
4. Gujarat

Q .9Q .9 Pr ime M inis ter  Narendra M odi  v is ited whic h of the fo l lowing s ac red s ites  in M aurit ius  on 1 2  M arc h 2 0 24  andPr ime M inis ter  Narendra M odi  v is ited whic h of the fo l lowing s ac red s ites  in M aurit ius  on 1 2  M arc h 2 0 24  and
offered pray ers  there?offered pray ers  there?

A nsA ns 1. Kandy Temple
2. Ganga Talao
3. Batu Caves
4. Pashupatinath Temple

Q .1 0Q .1 0 S omeone is  pol lut ing the r ivers  and lakes  by  throwing the was te generated in their  hous e.  In this  c ontext ,  whic h ofS omeone is  pol lut ing the r ivers  and lakes  by  throwing the was te generated in their  hous e.  In this  c ontext ,  whic h of
the fo l lowing Fundamental  Duties  is  being v io lated?the fo l lowing Fundamental  Duties  is  being v io lated?

A nsA ns 1. To strive toward excellence in all spheres of individual and collective activity
2. To cherish and follow the noble ideals
3. Value and preserve the rich heritage of the country
4. To protect and improve the natural environment

Q .1 1Q .1 1 Whic h c ompany  has  unvei led  an A I- powered G old- M elt ing ATM , trans forming gold  trans ac t ions  by  enabl ing us ersWhic h c ompany  has  unvei led  an A I- powered G old- M elt ing ATM , trans forming gold  trans ac t ions  by  enabl ing us ers
to  buy ,  s el l ,  exc hange,  leas e,  d igit is e and monetize gold?to  buy ,  s el l ,  exc hange,  leas e,  d igit is e and monetize gold?

A nsA ns 1. Muthoot Finance
2. Goldsikka
3. Tata Gold
4. HDFC Gold

Q .1 2Q .1 2 Whic h A rt ic le is  in the 7Whic h A rt ic le is  in the 7t h  t h  S c hedule of the C ons t itut ion of Ind ia?S c hedule of the C ons t itut ion of Ind ia?

A nsA ns 1. Article 289
2. Article 259
3. Article 244
4. Article 246

Q .1 3Q .1 3 The Pres ident nominates  ____ members  to  the Rajy a S abha bas ed on their  excel lence in l iterature,  s c ience,  art  andThe Pres ident nominates  ____ members  to  the Rajy a S abha bas ed on their  excel lence in l iterature,  s c ience,  art  and
s oc ial  s erv ice.s oc ia l  s erv ice.

A nsA ns 1. 10
2. 12
3. 8
4. 15

Q .1 4Q .1 4 Who among the fo l lowing was  the bes t- known C haluky a ruler  in terms  of mil itary  c onques ts?Who among the fo l lowing was  the bes t- known C haluky a ruler  in terms  of mil itary  c onques ts?
A nsA ns 1. Pulakesin II

2. Vikramaditya II
3. Pulakesin I
4. Kirtivarman II
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Q .1 5Q .1 5 Whic h A mendment to  the Indian C ons t itut ion added the word 'S oc ia l is t '  to  the Preamble?Whic h A mendment to  the Indian C ons t itut ion added the word 'S oc ia l is t '  to  the Preamble?
A nsA ns 1. 25th  Amendment

2. 42nd  Amendment

3. 44th  Amendment

4. 86th  Amendment

Q .1 6Q .1 6 In O c tober  2 0 24 ,  the newly  c ons truc ted roof of  whic h of the fo l lowing rai lway  s tat ions  got  damaged due to  heavyIn O c tober  2 0 24 ,  the newly  c ons truc ted roof of  whic h of the fo l lowing rai lway  s tat ions  got  damaged due to  heavy
rain,  whic h rais ed ques t ions  over  the Rai lway  M inis try  and the M aharas htra government?rain,  whic h rais ed ques t ions  over  the Rai lway  M inis try  and the M aharas htra government?

A nsA ns 1. Nagpur Railway Station
2. Mumbai Railway Station
3. Kalyan Railway Station
4. Ratnagiri Railway Station

Q .1 7Q .1 7 Whic h of the fo l lowing reports  highl ighted the explo itat ion and s exual  haras s ment of women in the M alay alam filmWhic h of the fo l lowing reports  highl ighted the explo itat ion and s exual  haras s ment of women in the M alay alam film
indus try ,  drawing attention to  the broader  is s ue of workplace haras s ment ,  in 2 0 24 ?indus try ,  drawing attention to  the broader  is s ue of workplace haras s ment ,  in 2 0 24 ?

A nsA ns 1. Justice Verma Committee Report
2. Justice Srikrishna Committee Report
3. Justice BN Srikrishna Arbitration Report
4. Justice Hema Committee Report

Q .1 8Q .1 8 A nkas amudra B ird  C ons ervat ion Res erve is  loc ated in whic h s tate of Ind ia?A nkas amudra B ird  C ons ervat ion Res erve is  loc ated in whic h s tate of Ind ia?
A nsA ns 1. 

2. 
3. 
4. 

Q .1 9Q .1 9 When was  the 'S ingh S abha M ovement '  founded in A mrits ar  to  provide modern Wes tern educ at ion to  S ikhs  andWhen was  the 'S ingh S abha M ovement '  founded in A mrits ar  to  provide modern Wes tern educ at ion to  S ikhs  and
c ounter  the pros ely t is ing ac t iv it ies  of  the C hr is t ian mis s ionar ies ,  Brahmo S amajis ts ,  A ry a S amajis ts  and M us l imc ounter  the pros ely t is ing ac t iv it ies  of  the C hr is t ian mis s ionar ies ,  Brahmo S amajis ts ,  A ry a S amajis ts  and M us l im
maulv is?maulv is?

A nsA ns 1. 1851
2. 1929
3. 1873
4. 1865

Q .2 0Q .2 0 Whic h of the fo l lowing events  was  the firs t  to  occ ur?Whic h of the fo l lowing events  was  the firs t  to  occ ur?
A nsA ns 1. Battle of Buxar

2. Third Battle of Panipat
3. First Anglo-Maratha War
4. Battle of Plassey

Q .2 1Q .2 1 V  is  the father  of M .  N is  the brother  of M .  O  is  the brother  of N.  L  is  the mother  of O.  How is  V  related to  L ?V  is  the father  of M .  N is  the brother  of M .  O  is  the brother  of N.  L  is  the mother  of O.  How is  V  related to  L ?
A nsA ns 1. Sister

2. Brother
3. Husband
4. Husband’s brother

Section : Logical Reasoning
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Q .2 2Q .2 2 What s hould  c ome in place of the ques t ion mark  ( ? )  in the given s er ies?What s hould  c ome in place of the ques t ion mark  ( ? )  in the given s er ies?

1 5/ 3 1 ,  1 9/ 3 9,  2 3/47,  ?  ,  3 1 /63,  3 5/ 711 5/ 3 1 ,  1 9/ 3 9,  2 3/47,  ?  ,  3 1 /63,  3 5/ 71
A nsA ns 1. 27/54

2. 29/58
3. 27/55
4. 29/59

Q .2 3Q .2 3 Refer  to  the fo l lowing letter  s er ies  and ans wer  the ques t ion that  fo l lows .  C ounting to  be done from left  to  r ightRefer  to  the fo l lowing letter  s er ies  and ans wer  the ques t ion that  fo l lows .  C ounting to  be done from left  to  r ight
only .only .

( L eft)  ( L eft)  D  D B  B  A  A  E  X  I  G  E  X  I  G  A  U S  A  U S  P  O  T  P  O  T  R R J  Q  J  Q  A  A  B  S  B  S  V  V  W W ( Right)( Right)

How many  s uc h vowels  are there that  are immediately  preceded by  a  c ons onant and als o  immediately  fo l lowed by  aHow many  s uc h vowels  are there that  are immediately  preceded by  a  c ons onant and als o  immediately  fo l lowed by  a
c ons onant?c ons onant?

A nsA ns 1. Three
2. One
3. Four
4. Two

Q .24Q .24 In a  c las s  of  70  s tudents ,  the rank  of Kaly an is  24  from the top.  Then,  what is  the rank  of Kaly an from the bottom?In a  c las s  of  70  s tudents ,  the rank  of Kaly an is  24  from the top.  Then,  what is  the rank  of Kaly an from the bottom?
A nsA ns 1. 

2. 
3. 
4. 

Q .2 5Q .2 5 If  ‘A’ s tands  for  ‘+ ’ ,  ‘B ’ s tands  for  ‘− ’ ,  ‘C ’ s tands  for  ‘÷ ’ and ‘D ’ s tands  for  ‘× ’ ,  then what wi l l  c ome in place of theIf  ‘A’ s tands  for  ‘+ ’ ,  ‘B ’ s tands  for  ‘− ’ ,  ‘C ’ s tands  for  ‘÷ ’ and ‘D ’ s tands  for  ‘× ’ ,  then what wi l l  c ome in place of the
ques t ion mark  ( ? )  in the fo l lowing equation?ques t ion mark  ( ? )  in the fo l lowing equation?

1 7  D 3  A  2  B  4  C  1  =  ?1 7  D 3  A  2  B  4  C  1  =  ?
A nsA ns 1. 49

2. 47
3. 45
4. 51

Q .2 6Q .2 6 S ix  boxes  A ,  B,  C ,  D,  E ,  and F are s tac ked one above the other  but not  neces s ar i ly  in the s ame order.  C  is  kept fourthS ix  boxes  A ,  B,  C ,  D,  E ,  and F are s tac ked one above the other  but not  neces s ar i ly  in the s ame order.  C  is  kept fourth
from the bottom.  O nly  one box is  kept between C  and E .  D  is  kept immediately  below F.  B  is  exac t ly  two pos it ionsfrom the bottom.  O nly  one box is  kept between C  and E .  D  is  kept immediately  below F.  B  is  exac t ly  two pos it ions
below F.  Whic h box is  s ec ond from the bottom?below F.  Whic h box is  s ec ond from the bottom?

A nsA ns 1. D
2. B
3. E
4. A

Q .2 7Q .2 7 What wi l l  c ome in place of the ques t ion mark  ( ? )  in the fo l lowing equation if  ‘+ ’ and ‘−’ are interc hanged and ‘× ’ andWhat wi l l  c ome in place of the ques t ion mark  ( ? )  in the fo l lowing equation if  ‘+ ’ and ‘−’ are interc hanged and ‘× ’ and
‘÷ ’ are interc hanged?‘÷ ’ are interc hanged?
2 6 ×  2  – 9  + 4  ÷  5 = ?2 6 ×  2  – 9  + 4  ÷  5 = ?

A nsA ns 1. 21
2. 22
3. 0
4. 2
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Q .2 8Q .2 8 What s hould  c ome in place of the ques t ion mark  ( ? )  in the given s er ies?What s hould  c ome in place of the ques t ion mark  ( ? )  in the given s er ies?

1 43  1 43  1 2 8 1 2 8 ?  ?  98 98 83  83  6868
A nsA ns 1. 111

2. 119
3. 113
4. 117

Q .2 9Q .2 9 DM  2 7  is  related to  B I  2 2  in a  certain way .  In the s ame way ,  UJ  1 3  is  related to  S F 8 .  To  whic h of the fo l lowing is  G LDM  2 7  is  related to  B I  2 2  in a  certain way .  In the s ame way ,  UJ  1 3  is  related to  S F 8 .  To  whic h of the fo l lowing is  G L
3 7  related ,  fo l lowing the s ame logic ?3 7  related ,  fo l lowing the s ame logic ?

A nsA ns 1. FJ 31
2. EI 31
3. EH 32
4. FH 31

Q .3 0Q .3 0 The fo l lowing options  c ontain two pairs  of  words ,  whic h are related to  eac h other  in a  certain way .  Three of theThe fo l lowing options  c ontain two pairs  of  words ,  whic h are related to  eac h other  in a  certain way .  Three of the
fo l lowing four  word pairs  are a l ike as  thes e have the s ame relat ions hip and thus  form a group.  Whic h word pair  isfo l lowing four  word pairs  are a l ike as  thes e have the s ame relat ions hip and thus  form a group.  Whic h word pair  is
the one that  does  not  belong to  that  group?the one that  does  not  belong to  that  group?

A nsA ns 1. 
2. 
3. 
4. 

Q .3 1Q .3 1 5 is  related to  3 9 fo l lowing a certain logic .  Fo l lowing the s ame logic ,  1 6  is  related to  1 1 6 .  To  whic h of the fo l lowing5 is  related to  3 9 fo l lowing a certain logic .  Fo l lowing the s ame logic ,  1 6  is  related to  1 1 6 .  To  whic h of the fo l lowing
is  2 3  related to ,  fo l lowing the s ame logic ?is  2 3  related to ,  fo l lowing the s ame logic ?
( NO TE :  O perat ions  s hould  be performed on the whole numbers ,  without break ing down the numbers  into  their( NO TE :  O perat ions  s hould  be performed on the whole numbers ,  without break ing down the numbers  into  their
c ons t ituent d igits .  E .g .  1 3  – O perat ions  on 1 3  s uc h as  adding/s ubtrac t ing/mult iply ing to  1 3  c an be performed.c ons t ituent d igits .  E .g .  1 3  – O perat ions  on 1 3  s uc h as  adding/s ubtrac t ing/mult iply ing to  1 3  c an be performed.
Break ing down 1 3  into  1  and 3  and then performing mathematic al  operat ions  on 1  and 3  is  not  a l lowed . )Break ing down 1 3  into  1  and 3  and then performing mathematic al  operat ions  on 1  and 3  is  not  a l lowed . )

A nsA ns 1. 161
2. 163
3. 165
4. 164

Q .3 2Q .3 2 Two s ets  of  numbers  are given below.  In eac h s et  of  numbers ,  certain mathematic al  operat ion(s)  on the firs tTwo s ets  of  numbers  are given below.  In eac h s et  of  numbers ,  certain mathematic al  operat ion(s)  on the firs t
number res ults  in the s ec ond number.  S imilar ly ,  certain mathematic al  operat ion(s)  on the s ec ond number res ultsnumber res ults  in the s ec ond number.  S imilar ly ,  certain mathematic al  operat ion(s)  on the s ec ond number res ults
in the third  number and s o  on.  Whic h of the given options  fo l lows  the s ame s et  of  operat ions  as  in the given s ets?  in the third  number and s o  on.  Whic h of the given options  fo l lows  the s ame s et  of  operat ions  as  in the given s ets?  
( NO TE :  O perat ions  s hould  be performed on the whole numbers ,  without break ing down the numbers  into  their( NO TE :  O perat ions  s hould  be performed on the whole numbers ,  without break ing down the numbers  into  their
c ons t ituent d igits .  E .g .  1 3  – O perat ions  on 1 3  s uc h as  adding /  s ubtrac t ing /  mult iply ing to  1 3  c an be performed.c ons t ituent d igits .  E .g .  1 3  – O perat ions  on 1 3  s uc h as  adding /  s ubtrac t ing /  mult iply ing to  1 3  c an be performed.
Break ing down 1 3  into  1  and 3  and then performing mathematic al  operat ions  on 1  and 3  is  not  a l lowed . )Break ing down 1 3  into  1  and 3  and then performing mathematic al  operat ions  on 1  and 3  is  not  a l lowed . )

8- 64 - 94 - 1 88;  9- 81 - 1 1 1 -2 2 28- 64 - 94 - 1 88;  9- 81 - 1 1 1 -2 2 2
A nsA ns 1. 5-25-55-120

2. 6-36-66-132
3. 10-100-120-240
4. 7-49-69-138
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Q .3 3Q .3 3 Refer  to  the given s er ies  and ans wer  the ques t ion that  fo l lows .  C ounting to  be done from left  to  r ight  only .  ( A l lRefer  to  the given s er ies  and ans wer  the ques t ion that  fo l lows .  C ounting to  be done from left  to  r ight  only .  ( A l l
numbers  are s ingle d igit  numbers  only)numbers  are s ingle d igit  numbers  only)
( L eft)  1  7  8  7  5 8  4  7  1  9  3  1  1  6  8  2  2  8  9  1  8  1  8  1  6  2  2  ( Right)( L eft)  1  7  8  7  5 8  4  7  1  9  3  1  1  6  8  2  2  8  9  1  8  1  8  1  6  2  2  ( Right)
How many  s uc h even numbers  are there eac h of whic h is  immediately  preceded by  an odd number and als oHow many  s uc h even numbers  are there eac h of whic h is  immediately  preceded by  an odd number and als o
immediately  fo l lowed by  an even number?immediately  fo l lowed by  an even number?

A nsA ns 1. Three
2. Two
3. Four
4. One

Q .3 4Q .3 4 E ac h vowel  in the word A BA NDO NA BL E  is  c hanged to  the s ec ond letter  fo l lowing it  in the E ngl is h a lphabetic alE ac h vowel  in the word A BA NDO NA BL E  is  c hanged to  the s ec ond letter  fo l lowing it  in the E ngl is h a lphabetic al
order  and eac h c ons onant is  c hanged to  the third  letter  preceding it  in the E ngl is h a lphabetic al  order.  Whic h of theorder  and eac h c ons onant is  c hanged to  the third  letter  preceding it  in the E ngl is h a lphabetic al  order.  Whic h of the
fo l lowing letters  wi l l  appear  exac t ly  twice in the letter- c lus ter  thus  formed?fol lowing letters  wi l l  appear  exac t ly  twice in the letter- c lus ter  thus  formed?

A nsA ns 1. I
2. Q
3. C
4. K

Q .3 5Q .3 5 S elec t  the pair  that  fo l lows  the s ame pattern as  that  fo l lowed by  the two pairs  given below.  Both pairs  fo l low theS elec t  the pair  that  fo l lows  the s ame pattern as  that  fo l lowed by  the two pairs  given below.  Both pairs  fo l low the
s ame pattern.  s ame pattern.  

VA R :  RXPVA R :  RXP
KBE  :  G YCKBE  :  G YC

A nsA ns 1. XMP : WNO
2. XLQ : WMO
3. YMR : ULN
4. ZOP : VLN

Q .3 6Q .3 6 What wi l l  c ome in the place of the ques t ion mark  ( ? )  in the fo l lowing equation,  i f  ‘+ ’ and ‘−’ are interc hanged,  and ‘× ’What wi l l  c ome in the place of the ques t ion mark  ( ? )  in the fo l lowing equation,  i f  ‘+ ’ and ‘−’ are interc hanged,  and ‘× ’
and ‘÷ ’ are interc hanged?and ‘÷ ’ are interc hanged?

3 0  ÷  1 0  + 4 0  ×  5 – 3  =?3 0  ÷  1 0  + 4 0  ×  5 – 3  =?
A nsA ns 1. 295

2. 305
3. 395
4. 205

Q .3 7Q .3 7 S elec t  the c orrec t  mirror  image of the given figure when the mirror  is  placed at  XY  as  s hown below.S elec t  the c orrec t  mirror  image of the given figure when the mirror  is  placed at  XY  as  s hown below.

A nsA ns 1. 
2. 
3. 
4. 
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Q .3 8Q .3 8 Refer  to  the fo l lowing letter  s er ies  and ans wer  the ques t ion that  fo l lows .  C ounting to  be done from left  to  r ightRefer  to  the fo l lowing letter  s er ies  and ans wer  the ques t ion that  fo l lows .  C ounting to  be done from left  to  r ight
only .only .

( L eft)  C  ( L eft)  C  X  X  U U W W J  J  O  O  J  J  F  F T  T  U U N N R R E  E  M  M  P P  L  L  F F W W H H Y  Y  M  M  ( Right)( Right)

How many  s uc h c ons onants  are there eac h of whic h is  immediately  preceded by  a  vowel  and als o  immediatelyHow many  s uc h c ons onants  are there eac h of whic h is  immediately  preceded by  a  vowel  and als o  immediately
fo l lowed by  a  c ons onant?fo l lowed by  a  c ons onant?

A nsA ns 1. Five
2. Three
3. Four
4. Two

Q .3 9Q .3 9 Three of the fo l lowing four  word- pairs  are a l ike in a  certain way  and thus  form a group.  Whic h word- pair  DO E S  NO TThree of the fo l lowing four  word- pairs  are a l ike in a  certain way  and thus  form a group.  Whic h word- pair  DO E S  NO T
belong to  that  group?belong to  that  group?
( The words  mus t be c ons idered as  meaningful  E ngl is h words  and mus t not  be related to  eac h other  bas ed on the( The words  mus t be c ons idered as  meaningful  E ngl is h words  and mus t not  be related to  eac h other  bas ed on the
number of letters/number of c ons onants/vowels  in the word . )number of letters/number of c ons onants/vowels  in the word . )

A nsA ns 1. Cat-Herd
2. Sheep-Flock
3. Wolf-Pack
4. Fish-School

Q .4 0Q .4 0 S elec t  the s et  that  fo l lows  the s ame pattern as  the one fo l lowed by  the two s ets  given below.  Both s ets  fo l low theS elec t  the s et  that  fo l lows  the s ame pattern as  the one fo l lowed by  the two s ets  given below.  Both s ets  fo l low the
s ame pattern.s ame pattern.

DF – A C  – XZDF – A C  – XZ
RT – O Q  – L NRT – O Q  – L N

A nsA ns 1. GI – DF – CE
2. GI – DF – AC
3. HJ – CF – AC
4. HJ – CE – DF

Q .4 1Q .4 1 S elec t  the mos t appropr iate A NTO NYM  of the given word .S elec t  the mos t appropr iate A NTO NYM  of the given word .

Prec iousPrec ious
A nsA ns 1. Valuable

2. Treasured
3. Worthless
4. Costly

Q .4 2Q .4 2 S elec t  the option that  c an be us ed as  a  one- word s ubs t itute for  the given group of words .S elec t  the option that  c an be us ed as  a  one- word s ubs t itute for  the given group of words .

A  pers on who s tudies  the weatherA  pers on who s tudies  the weather
A nsA ns 1. Physicist

2. Meteorologist
3. Psychologist
4. Chemist

Section : General English and Comprehension
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Q .43Q .43 S elec t  the mos t appropr iate option to  fil l  in the blank .S elec t  the mos t appropr iate option to  fil l  in the blank .

You c an’t  enter  the lab ______ y ou are wear ing proper  s afety  gear.You c an’t  enter  the lab ______ y ou are wear ing proper  s afety  gear.
A nsA ns 1. and

2. or
3. though
4. unless

Q .4 4Q .4 4 Identify  the id iom that  fits  the given s ituat ion.Identify  the id iom that  fits  the given s ituat ion.

M r.  Kanth had to  pay  an exorbitant  amount for  the v intage c ar  that  he bought for  his  eldes t  s on.M r.  Kanth had to  pay  an exorbitant  amount for  the v intage c ar  that  he bought for  his  eldes t  s on.
A nsA ns 1. To burn your boats

2. To pay through the nose
3. To hit the sack
4. To scrape the barrel

Q .4 5Q .4 5 S elec t  the mos t appropr iate option to  fil l  in the blank .S elec t  the mos t appropr iate option to  fil l  in the blank .
They  ___ their  homework  las t  night .They  ___ their  homework  las t  night .

A nsA ns 1. do
2. does
3. did
4. doing

C omprehens ion:C omprehens ion:
Read the given passage and answer the questions that follow. 

Human activities have become the leading cause of biodiversity loss across the globe. Rapid urbanisation, deforestation,
industrial expansion and pollution have significantly altered natural habitats. Overexploitation of biological resources and
introduction of invasive species further intensify the pressure on native ecosystems. These causes, driven largely by economic
development and population growth, disrupt the delicate balance of nature.

The effects of biodiversity loss are widespread and deeply concerning. Ecosystem services such as pollination, water purification
and climate regulation become compromised. The extinction of species affects food chains, leading to unpredictable ecological
consequences. For example, the loss of pollinators threatens agricultural productivity and food security for millions of people.

Furthermore, biodiversity loss contributes to environmental instability. It weakens the resilience of ecosystems, making them
more vulnerable to natural disasters and climate change. As habitats shrink and species disappear, the planet becomes less
capable of supporting life in all its forms, including human life.

S ubQ ues t ion No :  4 6S ubQ ues t ion No :  4 6
Q .4 6Q .4 6 S elec t  the mos t appropr iate A NTO NYM  of the given word from the pas s age.S elec t  the mos t appropr iate A NTO NYM  of the given word from the pas s age.

S turdyS turdy
A nsA ns 1. Rapid

2. Delicate
3. Unsustainable
4. Significant
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C omprehens ion:C omprehens ion:
Read the given passage and answer the questions that follow. 

Human activities have become the leading cause of biodiversity loss across the globe. Rapid urbanisation, deforestation,
industrial expansion and pollution have significantly altered natural habitats. Overexploitation of biological resources and
introduction of invasive species further intensify the pressure on native ecosystems. These causes, driven largely by economic
development and population growth, disrupt the delicate balance of nature.

The effects of biodiversity loss are widespread and deeply concerning. Ecosystem services such as pollination, water purification
and climate regulation become compromised. The extinction of species affects food chains, leading to unpredictable ecological
consequences. For example, the loss of pollinators threatens agricultural productivity and food security for millions of people.

Furthermore, biodiversity loss contributes to environmental instability. It weakens the resilience of ecosystems, making them
more vulnerable to natural disasters and climate change. As habitats shrink and species disappear, the planet becomes less
capable of supporting life in all its forms, including human life.

S ubQ ues t ion No :  47S ubQ ues t ion No :  47
Q .47Q .47 S elec t  the mos t appropr iate t it le for  the given pas s age.S elec t  the mos t appropr iate t it le for  the given pas s age.
A nsA ns 1. Biodiversity in Decline: Human Actions and Their Impact

2. Protecting Biodiversity for Future Generations
3. Biodiversity and Conservation Methods
4. Biodiversity and Ecosystem Services

C omprehens ion:C omprehens ion:
Read the given passage and answer the questions that follow. 

Human activities have become the leading cause of biodiversity loss across the globe. Rapid urbanisation, deforestation,
industrial expansion and pollution have significantly altered natural habitats. Overexploitation of biological resources and
introduction of invasive species further intensify the pressure on native ecosystems. These causes, driven largely by economic
development and population growth, disrupt the delicate balance of nature.

The effects of biodiversity loss are widespread and deeply concerning. Ecosystem services such as pollination, water purification
and climate regulation become compromised. The extinction of species affects food chains, leading to unpredictable ecological
consequences. For example, the loss of pollinators threatens agricultural productivity and food security for millions of people.

Furthermore, biodiversity loss contributes to environmental instability. It weakens the resilience of ecosystems, making them
more vulnerable to natural disasters and climate change. As habitats shrink and species disappear, the planet becomes less
capable of supporting life in all its forms, including human life.

S ubQ ues t ion No :  4 8S ubQ ues t ion No :  4 8
Q .4 8Q .4 8 What is  the main idea of the pas s age?What is  the main idea of the pas s age?
A nsA ns 1. The main idea of the passage is to explain the importance of biodiversity conservation, highlight the causes of biodiversity

loss and discuss its effects on ecosystems and human well-being.
2. The main idea of the passage is to explain the role of biodiversity in human development, discuss its types and explore

methods of conservation.
3. The main idea of the passage is to explain the methods of biodiversity conservation, highlight the types of biodiversity and

discuss its effects on ecosystems and human well-being.
4. The main idea of the passage is to describe the causes of biodiversity conservation, explain its importance and discuss its

effects on agricultural productivity.
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C omprehens ion:C omprehens ion:
Read the given passage and answer the questions that follow. 

Human activities have become the leading cause of biodiversity loss across the globe. Rapid urbanisation, deforestation,
industrial expansion and pollution have significantly altered natural habitats. Overexploitation of biological resources and
introduction of invasive species further intensify the pressure on native ecosystems. These causes, driven largely by economic
development and population growth, disrupt the delicate balance of nature.

The effects of biodiversity loss are widespread and deeply concerning. Ecosystem services such as pollination, water purification
and climate regulation become compromised. The extinction of species affects food chains, leading to unpredictable ecological
consequences. For example, the loss of pollinators threatens agricultural productivity and food security for millions of people.

Furthermore, biodiversity loss contributes to environmental instability. It weakens the resilience of ecosystems, making them
more vulnerable to natural disasters and climate change. As habitats shrink and species disappear, the planet becomes less
capable of supporting life in all its forms, including human life.

S ubQ ues t ion No :  4 9S ubQ ues t ion No :  4 9
Q .4 9Q .4 9 Identify  the s truc ture of the pas s age.Identify  the s truc ture of the pas s age.
A nsA ns 1. Chronological

2. Compare and Contrast
3. Cause and Effect
4. Descriptive

C omprehens ion:C omprehens ion:
Read the given passage and answer the questions that follow. 

Human activities have become the leading cause of biodiversity loss across the globe. Rapid urbanisation, deforestation,
industrial expansion and pollution have significantly altered natural habitats. Overexploitation of biological resources and
introduction of invasive species further intensify the pressure on native ecosystems. These causes, driven largely by economic
development and population growth, disrupt the delicate balance of nature.

The effects of biodiversity loss are widespread and deeply concerning. Ecosystem services such as pollination, water purification
and climate regulation become compromised. The extinction of species affects food chains, leading to unpredictable ecological
consequences. For example, the loss of pollinators threatens agricultural productivity and food security for millions of people.

Furthermore, biodiversity loss contributes to environmental instability. It weakens the resilience of ecosystems, making them
more vulnerable to natural disasters and climate change. As habitats shrink and species disappear, the planet becomes less
capable of supporting life in all its forms, including human life.

S ubQ ues t ion No :  50S ubQ ues t ion No :  50
Q . 50Q . 50 S elec t  the mos t appropr iate A NTO NYM  of the given word from the pas s age.S elec t  the mos t appropr iate A NTO NYM  of the given word from the pas s age.

Protec tedProtec ted
A nsA ns 1. Severe

2. Critical
3. Vulnerable
4. Widespread

Section : General Hindi and Comprehension
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Q . 51Q . 51 सहीसही   का र कका र क   [च][च]   काका   चयनचयन   क रक र   वा aवा a   कोको   प ूणfप ूणf   कg hजएकg hजए ।।
'  '  वहवह   चl दचl द  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . दे ख तादे ख ता   हैहै । '। '

A nsA ns 1. के rारा
2. को
3. ऊपर
4. के hलए

Q . 52Q . 52 uनvhलwख तuनvhलwख त   uवक xyuवक xy   म{म{   सेसे   मुहा वरेमुहा वरे   काका   सहीसही   अथfअथf   चुन{चुन{ ।।

‘‘ बा तबा त   काका   धनीधनी ’ ’ काका   अथfअथf   हैहै ।।
A nsA ns 1. वायदे का प�ा

2. लगातार बात करना
3. �ादा बात करना
4. बहुत �ानी होना

Q . 53Q . 53 uनvhलwख तuनvhलwख त   uवक xyuवक xy   म{म{   सेसे   चनाचना   काका   प य� यवा चीप य� यवा ची   श�श�   प हचा न{प हचा न{ ।।
A nsA ns 1. uवधु

2. र�हला
3. आनन
4. पटु

Q . 54Q . 54 uनvhलwख तuनvhलwख त   uवक xyuवक xy   म{म{   सेसे   मुहा वरेमुहा वरे   काका   सहीसही   अथfअथf   चुन{चुन{ ।।
‘‘ hसरhसर   उ ठा नाउ ठा ना ’’

A nsA ns 1. uवरोध म{ खड़ा होना
2. hसर म{ खुजली होना
3. पागल हो जाना
4. hसर म{ ददf  होना

Q . 55Q . 55 ‘‘ उ � मउ � म ’ ’ काका   प य� यवा चीप य� यवा ची   श�श�   हो गाहो गा --
A nsA ns 1. ख़राब              

2 . अनु�म
3. �े�      
4. शे�       

C omprehens ion:C omprehens ion:
�दए गए ग��श के आधार पर uनv�िकत ��y के उ�र दीhजए--
भारतीय राजनीuत म{ �े�ीयतावाद के अनेक कारण ह�, य�िप िकसी भी आधार पर �े�वाद कg भावना uवकhसत न हो इसके hलए संuवधान म{ इकहर� नाग�रकता कg
�व ा कg गई है । �थम भौगोhलक कारण ह�, कुछ ऐसे बड़े  रा� ह� hजनके छोटे-छोटे मह¥पूणf �े� भौगोhलक ¦ि§ से इकाई बन सकते ह� जैसे राज ान म{
मारवाड एवं मेवाड़। �rतीय भाषा एवं संªृuत का है hजसके कारण अनेक �े�ीय भावनाएँ ज­ लेती ह�। तृतीय आ®थfक कारण है। महारा§̄, गुजरात, कन�टक आ�द
uवकhसत रा� ह� जबिक uबहार, पूव°�र के रा�, उड़ीसा, उ.� आ�द ±ूनतम uवकhसत रा� ह�। इन रा�y के बीच मतभेद उभरना ²ाभाuवक है। चौथा कारण ह�
जाuत, hजसके कारण �े�ीयतावाद बढ़ा है। ह�रयाणा और महारा§̄ म{ �े�ीयता कg �वृ®� फैलाने म{ जाuत का मह¥पूणf  ान रहा है। पlचवl अनेक राजनीuतक
कारणy से भी �े�वाद कg भावना पनपती है। स¶ं®धत �े� के राजनीuत�y को यह ²ाथf �दखने लगता है िक य�द उस �े� uवशेष को पृथक रा� का दज� uमल जाए
तो उनकg राजनीuतक भूख uमट सकती है।

S ubQ ues t ion No :  56S ubQ ues t ion No :  56
Q . 56Q . 56 भा र तभा र त   म{म{   �े�ी यता वा द�े�ी यता वा द   काका   का र णका र ण   नह·नह·   हैहै - -- -
A nsA ns 1. धाuमfक

2. भाषा एवं संªृuत
3. आ®थfक
4. भौगोhलक
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C omprehens ion:C omprehens ion:
�दए गए ग��श के आधार पर uनv�िकत ��y के उ�र दीhजए--
भारतीय राजनीuत म{ �े�ीयतावाद के अनेक कारण ह�, य�िप िकसी भी आधार पर �े�वाद कg भावना uवकhसत न हो इसके hलए संuवधान म{ इकहर� नाग�रकता कg
�व ा कg गई है । �थम भौगोhलक कारण ह�, कुछ ऐसे बड़े  रा� ह� hजनके छोटे-छोटे मह¥पूणf �े� भौगोhलक ¦ि§ से इकाई बन सकते ह� जैसे राज ान म{
मारवाड एवं मेवाड़। �rतीय भाषा एवं संªृuत का है hजसके कारण अनेक �े�ीय भावनाएँ ज­ लेती ह�। तृतीय आ®थfक कारण है। महारा§̄, गुजरात, कन�टक आ�द
uवकhसत रा� ह� जबिक uबहार, पूव°�र के रा�, उड़ीसा, उ.� आ�द ±ूनतम uवकhसत रा� ह�। इन रा�y के बीच मतभेद उभरना ²ाभाuवक है। चौथा कारण ह�
जाuत, hजसके कारण �े�ीयतावाद बढ़ा है। ह�रयाणा और महारा§̄ म{ �े�ीयता कg �वृ®� फैलाने म{ जाuत का मह¥पूणf  ान रहा है। पlचवl अनेक राजनीuतक
कारणy से भी �े�वाद कg भावना पनपती है। स¶ं®धत �े� के राजनीuत�y को यह ²ाथf �दखने लगता है िक य�द उस �े� uवशेष को पृथक रा� का दज� uमल जाए
तो उनकg राजनीuतक भूख uमट सकती है।

S ubQ ues t ion No :  57S ubQ ues t ion No :  57
Q . 57Q . 57 भा र तभा र त   केके   िक निक न   रा �yरा �y   म{म{   जा uतजा uत   केके   आ धा रआ धा र   प रप र   �े�ी यता वा द�े�ी यता वा द   म{म{   बढ़ो � र�बढ़ो � र�   हुईहुई   हैहै - -- -
A nsA ns 1. पूव°�र रा�

2. ह�रयाणा और महारा§̄
3. उ.� एवं uबहार
4. गुजरात एवं कन�टक

C omprehens ion:C omprehens ion:
�दए गए ग��श के आधार पर uनv�िकत ��y के उ�र दीhजए--
भारतीय राजनीuत म{ �े�ीयतावाद के अनेक कारण ह�, य�िप िकसी भी आधार पर �े�वाद कg भावना uवकhसत न हो इसके hलए संuवधान म{ इकहर� नाग�रकता कg
�व ा कg गई है । �थम भौगोhलक कारण ह�, कुछ ऐसे बड़े  रा� ह� hजनके छोटे-छोटे मह¥पूणf �े� भौगोhलक ¦ि§ से इकाई बन सकते ह� जैसे राज ान म{
मारवाड एवं मेवाड़। �rतीय भाषा एवं संªृuत का है hजसके कारण अनेक �े�ीय भावनाएँ ज­ लेती ह�। तृतीय आ®थfक कारण है। महारा§̄, गुजरात, कन�टक आ�द
uवकhसत रा� ह� जबिक uबहार, पूव°�र के रा�, उड़ीसा, उ.� आ�द ±ूनतम uवकhसत रा� ह�। इन रा�y के बीच मतभेद उभरना ²ाभाuवक है। चौथा कारण ह�
जाuत, hजसके कारण �े�ीयतावाद बढ़ा है। ह�रयाणा और महारा§̄ म{ �े�ीयता कg �वृ®� फैलाने म{ जाuत का मह¥पूणf  ान रहा है। पlचवl अनेक राजनीuतक
कारणy से भी �े�वाद कg भावना पनपती है। स¶ं®धत �े� के राजनीuत�y को यह ²ाथf �दखने लगता है िक य�द उस �े� uवशेष को पृथक रा� का दज� uमल जाए
तो उनकg राजनीuतक भूख uमट सकती है।

S ubQ ues t ion No :  58S ubQ ues t ion No :  58
Q . 58Q . 58 uनvuनv   म{म{   सेसे  ' ' uव®भ¸ ताuव®भ¸ ता '  '  काका   uवलो मuवलो म   श�श�   हैहै --
A nsA ns 1. एकता

2. पाथfa
3. uवuवधता
4. समानता

C omprehens ion:C omprehens ion:
�दए गए ग��श के आधार पर uनv�िकत ��y के उ�र दीhजए--
भारतीय राजनीuत म{ �े�ीयतावाद के अनेक कारण ह�, य�िप िकसी भी आधार पर �े�वाद कg भावना uवकhसत न हो इसके hलए संuवधान म{ इकहर� नाग�रकता कg
�व ा कg गई है । �थम भौगोhलक कारण ह�, कुछ ऐसे बड़े  रा� ह� hजनके छोटे-छोटे मह¥पूणf �े� भौगोhलक ¦ि§ से इकाई बन सकते ह� जैसे राज ान म{
मारवाड एवं मेवाड़। �rतीय भाषा एवं संªृuत का है hजसके कारण अनेक �े�ीय भावनाएँ ज­ लेती ह�। तृतीय आ®थfक कारण है। महारा§̄, गुजरात, कन�टक आ�द
uवकhसत रा� ह� जबिक uबहार, पूव°�र के रा�, उड़ीसा, उ.� आ�द ±ूनतम uवकhसत रा� ह�। इन रा�y के बीच मतभेद उभरना ²ाभाuवक है। चौथा कारण ह�
जाuत, hजसके कारण �े�ीयतावाद बढ़ा है। ह�रयाणा और महारा§̄ म{ �े�ीयता कg �वृ®� फैलाने म{ जाuत का मह¥पूणf  ान रहा है। पlचवl अनेक राजनीuतक
कारणy से भी �े�वाद कg भावना पनपती है। स¶ं®धत �े� के राजनीuत�y को यह ²ाथf �दखने लगता है िक य�द उस �े� uवशेष को पृथक रा� का दज� uमल जाए
तो उनकg राजनीuतक भूख uमट सकती है।

S ubQ ues t ion No :  59S ubQ ues t ion No :  59
Q . 59Q . 59 uनvuनv   म{म{   सेसे  ' ' एक ताएक ता '  '  काका   uवलो मuवलो म   श�श�   हैहै --
A nsA ns 1. अखंडता

2. अश�uत
3. अनेकता
4. समझौता
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C omprehens ion:C omprehens ion:
�दए गए ग��श के आधार पर uनv�िकत ��y के उ�र दीhजए--
भारतीय राजनीuत म{ �े�ीयतावाद के अनेक कारण ह�, य�िप िकसी भी आधार पर �े�वाद कg भावना uवकhसत न हो इसके hलए संuवधान म{ इकहर� नाग�रकता कg
�व ा कg गई है । �थम भौगोhलक कारण ह�, कुछ ऐसे बड़े  रा� ह� hजनके छोटे-छोटे मह¥पूणf �े� भौगोhलक ¦ि§ से इकाई बन सकते ह� जैसे राज ान म{
मारवाड एवं मेवाड़। �rतीय भाषा एवं संªृuत का है hजसके कारण अनेक �े�ीय भावनाएँ ज­ लेती ह�। तृतीय आ®थfक कारण है। महारा§̄, गुजरात, कन�टक आ�द
uवकhसत रा� ह� जबिक uबहार, पूव°�र के रा�, उड़ीसा, उ.� आ�द ±ूनतम uवकhसत रा� ह�। इन रा�y के बीच मतभेद उभरना ²ाभाuवक है। चौथा कारण ह�
जाuत, hजसके कारण �े�ीयतावाद बढ़ा है। ह�रयाणा और महारा§̄ म{ �े�ीयता कg �वृ®� फैलाने म{ जाuत का मह¥पूणf  ान रहा है। पlचवl अनेक राजनीuतक
कारणy से भी �े�वाद कg भावना पनपती है। स¶ं®धत �े� के राजनीuत�y को यह ²ाथf �दखने लगता है िक य�द उस �े� uवशेष को पृथक रा� का दज� uमल जाए
तो उनकg राजनीuतक भूख uमट सकती है।

S ubQ ues t ion No :  60S ubQ ues t ion No :  60
Q .60Q .60 भा र ती यभा र ती य   संuवधा नसंuवधा न   rा राrा रा   �े�ी यता वा द�े�ी यता वा द   कोको   रो क नेरो क ने   केके   hलएhलए   � व ा� व ा   कgकg   ग ईग ई   हैहै - -- -
A nsA ns 1. इकहर� नाग�रकता कg

2. आ®थfक अनुदानो कg
3. सामाhसक संªृuत कg
4. दोहर� नाग�रकता कg

Q .61Q .61 Whic h of the fo l lowing features  in mos t  emai l  c l ients  helps  us ers  quic k ly  find a s pec ific  emai l  from a large numberWhic h of the fo l lowing features  in mos t  emai l  c l ients  helps  us ers  quic k ly  find a s pec ific  emai l  from a large number
of emai ls  by  s pec ify ing c r iter ia  s uc h as  s ender,  date,  or  key words?of emai ls  by  s pec ify ing c r iter ia  s uc h as  s ender,  date,  or  key words?

A nsA ns 1. Folders
2. Labels
3. Search Bar
4. Filters

Q .62Q .62 Whic h tool  is  us ed to  quic k ly  c opy  formatt ing from one cel l  to  another  in M S  E xcel?Whic h tool  is  us ed to  quic k ly  c opy  formatt ing from one cel l  to  another  in M S  E xcel?
A nsA ns 1. Copy & Paste

2. Format Painter
3. Conditional Formatting
4. Data Validation

Q .63Q .63 In M S  E xcel ,  whic h of the fo l lowing key s  mus t be us ed to  c ancel  a  text  or  number entry  before c omplet ing it  in theIn M S  E xcel ,  whic h of the fo l lowing key s  mus t be us ed to  c ancel  a  text  or  number entry  before c omplet ing it  in the
cel l  of  a  s preads heet?cel l  of  a  s preads heet?

A nsA ns 1. Delete
2. Enter
3. Backspace
4. Esc

Q .64Q .64 What is  the purpos e of the 'F ind and Replace'  feature in M S - Word proces s ing s oftware?What is  the purpos e of the 'F ind and Replace'  feature in M S - Word proces s ing s oftware?
A nsA ns 1. To create a copy of the document

2. To replace a word or phrase with another word or phrase
3. To check spelling errors
4. To insert a table

Q .65Q .65
A nsA ns 1. 

2. 
3. 
4. 

Section : Basic Knowledge of Computer
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Q .66Q .66 What does  the term ‘Doc ument Propert ies’ refer  to  in M S  Word?What does  the term ‘Doc ument Propert ies’ refer  to  in M S  Word?
A nsA ns 1. Properties that define the document’s appearance

2. Features that help you proofread the document
3. Information about the document, such as author, title and keywords
4. Functions that automate document formatting

Q .67Q .67 Whic h of the fo l lowing options  is  us ed to  s ave an M S  PowerPoint  pres entat ion under  a  d ifferent name?Whic h of the fo l lowing options  is  us ed to  s ave an M S  PowerPoint  pres entat ion under  a  d ifferent name?
A nsA ns 1. File > Close

2. File > Save As
3. File > Print
4. File > Save

Q .68Q .68 Whic h of the fo l lowing methods  do we NO T apply  for  s ec ur ing a s martphone?Whic h of the fo l lowing methods  do we NO T apply  for  s ec ur ing a s martphone?
A nsA ns 1. Use a strong password

2. Use pattern to unlock phone
3. Use a pin
4. Use free Wi-Fi

Q .69Q .69 What is  the pr imary  purpos e of c onnec t ing A adhaar  to  bank  acc ounts  for  D irec t  Benefit Trans fer  ( DBT) ?What is  the pr imary  purpos e of c onnec t ing A adhaar  to  bank  acc ounts  for  D irec t  Benefit Trans fer  ( DBT) ?
A nsA ns 1. To provide credit scores for loan applications

2. To facilitate online shopping payments
3. To ensure subsidies and benefits reach the intended beneficiaries directly and efficiently
4. To enable international money transfers

Q .70Q .70 Whic h of the fo l lowing bes t  des c r ibes  the ro le of  the S M TP protoc ol  in the proces s  of s ending an elec tronic  mai l?Whic h of the fo l lowing bes t  des c r ibes  the ro le of  the S M TP protoc ol  in the proces s  of s ending an elec tronic  mai l?
A nsA ns 1. SMTP encrypts emails end-to-end to ensure secure communication between sender and recipient.

2. SMTP handles the transfer of emails from the sender's email client to the recipient's email server.
3. SMTP allows the recipient to read emails in their web browser without downloading them.
4. SMTP is responsible for storing emails on the server until they are retrieved by the recipient.

Q .71Q .71 M S  Word 's  _____ func t ion fac i l itates  the c reat ion of l is ts  in doc uments .M S  Word 's  _____ func t ion fac i l itates  the c reat ion of l is ts  in doc uments .
A nsA ns 1. WordArt

2. Spell check
3. Mail Merge
4. Numbering and Bullets

Q .72Q .72 Whic h of the fo l lowing is  res pons ible for  provid ing e- infras truc ture for  del ivery  of e- s erv ices?Whic h of the fo l lowing is  res pons ible for  provid ing e- infras truc ture for  del ivery  of e- s erv ices?
A nsA ns 1. e-Government

2. e-Industry
3. e-Learning
4. e-Inclusion

Q .73Q .73 In M S  PowerPoint ,  upon performing whic h of the fo l lowing s teps  wi l l  s l ides  progres s  automatic al ly  after  aIn M S  PowerPoint ,  upon performing whic h of the fo l lowing s teps  wi l l  s l ides  progres s  automatic al ly  after  a
predetermined amount of t ime in a  s l ide s how?predetermined amount of t ime in a  s l ide s how?

A nsA ns 1. Slide Show -> Use Timings
2. Insert -> Auto Advance
3. View -> Set Timings
4. Design -> Set Timings
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Q .74Q .74 Whic h of the fo l lowing s teps  is  neces s ary  to  c reate a  c us tom font s ize that  is  NO T l is ted in the Font S ize drop-Whic h of the fo l lowing s teps  is  neces s ary  to  c reate a  c us tom font s ize that  is  NO T l is ted in the Font S ize drop-
down menu in M S  Word?down menu in M S  Word?

A nsA ns 1. Use the Increase Font Size button until the desired size is reached.
2. Right-click the text and choose Increase Font Size from the context menu.
3. Custom font sizes cannot be created in MS Word.
4. Type the desired font size directly into the Font Size box and press Enter.

Q .75Q .75 Whic h option is  us ed for  c hanging the func t ion of the left  and r ight  buttons  of the mous e in the M ous e andWhic h option is  us ed for  c hanging the func t ion of the left  and r ight  buttons  of the mous e in the M ous e and
Touc hpad window under  the Hardware s ec t ion of S y s tem S ett ings  in Ubuntu O S ?Touc hpad window under  the Hardware s ec t ion of S y s tem S ett ings  in Ubuntu O S ?

A nsA ns 1. Double-click
2. Mouse colour
3. Primary button
4. Pointer speed

Q .76Q .76 Whic h of the fo l lowing key board c ombinat ions  is  us ed for  wr it ing s ubs c r ipt  in an M S  Word doc ument?Whic h of the fo l lowing key board c ombinat ions  is  us ed for  wr it ing s ubs c r ipt  in an M S  Word doc ument?
A nsA ns 1. Ctrl + =

2. Ctrl + *
3. Ctrl + −
4. Ctrl + _

Q .77Q .77 Whic h of the fo l lowing pr int ing qual it ies  is  NO T pres ent under  the pr inter  propert ies?Whic h of the fo l lowing pr int ing qual it ies  is  NO T pres ent under  the pr inter  propert ies?
A nsA ns 1. Text

2. Standard
3. Box
4. Lines

Q .78Q .78 What is  rans omware?What is  rans omware?
A nsA ns 1. A system update tool

2. A method for backing up data
3. A type of malware that encrypts a user's files and demands payment for the decryption key
4. A type of antivirus software

Q .79Q .79 How many  items  c an y ou normally  keep and acces s  at  once in M ic ros oft  Word whi le us ing the C l ipboard?How many  items  c an y ou normally  keep and acces s  at  once in M ic ros oft  Word whi le us ing the C l ipboard?
A nsA ns 1. 26

2. 24
3. 30
4. 25

Q .80Q .80 Whic h of the fo l lowing options  is  us ed s o  that  the adjus tments  c an be made,  and doc ument c an be v iewed?Whic h of the fo l lowing options  is  us ed s o  that  the adjus tments  c an be made,  and doc ument c an be v iewed?
A nsA ns 1. Print Preview

2. Recent
3. New
4. Open

Section : Quantitative Aptitude
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Q .81Q .81

A nsA ns 1. 
            
           

2 . 

3. 
             
             
             
            

4. 
           

Q .82Q .82 A  vendor  rec overs  the c os t  of  60  pens  by  s el l ing 50  pens .  What is  his  percentage profit?A  vendor  rec overs  the c os t  of  60  pens  by  s el l ing 50  pens .  What is  his  percentage profit?
A nsA ns 1. 10%

2. 25%
3. 20%
4. 50%

Q .83Q .83

A nsA ns 1. ₹1,920
2. ₹1,820
3. ₹1,650
4. ₹1,720

Q .84Q .84 S ix  y ears  ago ,  the rat io  of  the ages  of K and P  was  5 :  6 .  Four  y ears  hence,  the rat io  of  their  ages  wi l l  be 1 0  :  1 1 .S ix  y ears  ago ,  the rat io  of  the ages  of K and P  was  5 :  6 .  Four  y ears  hence,  the rat io  of  their  ages  wi l l  be 1 0  :  1 1 .
What is  the pres ent age ( in y ears)  of  P?What is  the pres ent age ( in y ears)  of  P?

A nsA ns 1. 26
2. 18
3. 22
4. 16

Q .85Q .85 How many  natural  numbers  l ie between the s quares  of 98 and 99?  How many  natural  numbers  l ie between the s quares  of 98 and 99?  
A nsA ns 1. 99

2. 100
3. 158
4. 196

Q .86Q .86 A malaA mala ′s  s alary  was  ₹2 0 ,0 0 ,0 0 0  per  annum.  The s alary  was  inc reas ed to  ₹2 5,0 0 ,0 0 0  per  annum.  Find thes  s alary  was  ₹2 0 ,0 0 ,0 0 0  per  annum.  The s alary  was  inc reas ed to  ₹2 5,0 0 ,0 0 0  per  annum.  Find the
percentage inc reas e.percentage inc reas e.

A nsA ns 1. 15%
2. 25%
3. 20%
4. 35%
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Q .87Q .87 What is  the average s peed of a  bus  whic h c overs  half  the d is tance with a  s peed of 72  km/ hr  and the other  half  withWhat is  the average s peed of a  bus  whic h c overs  half  the d is tance with a  s peed of 72  km/ hr  and the other  half  with
a s peed of 3 6  km/ hr?a s peed of 3 6  km/ hr?

A nsA ns 1. 55 km/hr
2. 44 km/hr
3. 48 km/hr
4. 40 km/hr

Q .88Q .88

A nsA ns 1. 

           
2 . 

            
3. 

           
4. 

QQ
..
88
99
AA
nn
ss

1. 

2. 
3. 
4. 

Q .90Q .90 A  merc hant has  announced 4 0 % dis c ount on pr ices  of ready made garments  at  the t ime of s ale.  I f  a  c us tomerA  merc hant has  announced 4 0 % dis c ount on pr ices  of ready made garments  at  the t ime of s ale.  I f  a  c us tomer
needs  to  have a  d is c ount of ₹1 2 ,80 0 ,  then how many  s hirts  eac h c os t ing him ₹6 ,4 0 0  s hould  he purc has e?needs  to  have a  d is c ount of ₹1 2 ,80 0 ,  then how many  s hirts  eac h c os t ing him ₹6 ,4 0 0  s hould  he purc has e?

A nsA ns 1. Two
2. Five
3. Three
4. Four

Q .91Q .91 In an elec t ion between two c andidates ,  90 % of the regis tered voters  c as t  their  vote and 2 0 % of the votes  pol ledIn an elec t ion between two c andidates ,  90 % of the regis tered voters  c as t  their  vote and 2 0 % of the votes  pol led
were found inval id .  The winning c andidate got  75% of the val id  votes  and won the elec t ion by  a  margin of 1 0 71were found inval id .  The winning c andidate got  75% of the val id  votes  and won the elec t ion by  a  margin of 1 0 71
votes .  How many  voters  were regis tered?votes .  How many  voters  were regis tered?

A nsA ns 1. 2977
2. 2973
3. 2975
4. 2974

Q .92Q .92 A  motor  c ar  s tarts  with a  s peed of 60  km/ h and inc reas es  its  s peed after  every  two hours  by  1 5 km/ h.  In how muc hA  motor  c ar  s tarts  with a  s peed of 60  km/ h and inc reas es  its  s peed after  every  two hours  by  1 5 km/ h.  In how muc h
time wi l l  i t  c over  a  d is tance of 3 60  km?time wi l l  i t  c over  a  d is tance of 3 60  km?

A nsA ns 1. 5 hours 
2. 9 hours 
3. 2 hours
4. 7 hours 
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Q .93Q .93 The s um of five numbers  is  655.  The average of the firs t  two numbers  is  76  and the third  number is  1 1 5.  F ind theThe s um of five numbers  is  655.  The average of the firs t  two numbers  is  76  and the third  number is  1 1 5.  F ind the
average of the remaining two numbers?average of the remaining two numbers?

A nsA ns 1. 192
2. 191
3. 195
4. 194

Q .94Q .94 O ne tap takes  1 8  minutes  to  fil l  a  tank ,  whi le another  takes  4 0  minutes  to  empty  the s ame tank .  What is  the t imeO ne tap takes  1 8  minutes  to  fil l  a  tank ,  whi le another  takes  4 0  minutes  to  empty  the s ame tank .  What is  the t ime
( in minutes)  taken to  fil l  the tank ,  i f  both the taps  are opened s imultaneous ly ?( in minutes)  taken to  fil l  the tank ,  i f  both the taps  are opened s imultaneous ly ?

A nsA ns 1. 
           

2 . 
            

3. 
           

4. 
           

Q .95Q .95 A  s hopkeeper  dec lares  1 8% dis c ount on the marked pr ice of a  TV  s et .  I f  the s el l ing pr ice of the TV  s et  is  ₹3 0 ,1 76 ,A  s hopkeeper  dec lares  1 8% dis c ount on the marked pr ice of a  TV  s et .  I f  the s el l ing pr ice of the TV  s et  is  ₹3 0 ,1 76 ,
then the marked pr ice of the TV  s et  is :then the marked pr ice of the TV  s et  is :

A nsA ns 1. ₹36,600
2. ₹36,500
3. ₹36,400
4. ₹36,800

Q .96Q .96 A fter  three s ucces s ive equal  percentage hikes  in s alary ,  a  s um of ₹3 0 ,0 0 0  turned into  ₹3 6 ,751 .2 9 .  F ind theA fter  three s ucces s ive equal  percentage hikes  in s alary ,  a  s um of ₹3 0 ,0 0 0  turned into  ₹3 6 ,751 .2 9 .  F ind the
percentage r is e in s alary  at  eac h s tage.percentage r is e in s alary  at  eac h s tage.

A nsA ns 1. 7%
2. 5%
3. 6%
4. 8%

Q .97Q .97 E valuate the fo l lowing:E valuate the fo l lowing:

3 5 − [ 2 5 − { 3 1  − ( 2 2  − 1 1  + 9) } ]3 5 − [ 2 5 − { 3 1  − ( 2 2  − 1 1  + 9) } ]
A nsA ns 1. 21

2. 24
3. 18
4. 20

Q .98Q .98 5 t imes  the pres ent age of Kirt i  is  1 4  y ears  more than 7  t imes  the pres ent age of Rajes h,  and 8  t imes  the pres ent5 t imes  the pres ent age of Kirt i  is  1 4  y ears  more than 7  t imes  the pres ent age of Rajes h,  and 8  t imes  the pres ent
age of Rajes h is  1 1  y ears  les s  than 5 t imes  the pres ent age of Kirt i .  The s um of the pres ent ages  ( in y ears)  of  Kirt iage of Rajes h is  1 1  y ears  les s  than 5 t imes  the pres ent age of Kirt i .  The s um of the pres ent ages  ( in y ears)  of  Kirt i
and Rajes h is :and Rajes h is :

A nsA ns 1. 12
2. 5
3. 11
4. 10
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Q .99Q .99 The average of the marks  of 1 5 s tudents  in a  c las s  is  51 .  I f  the marks  of eac h s tudent are doubled ,  find the newThe average of the marks  of 1 5 s tudents  in a  c las s  is  51 .  I f  the marks  of eac h s tudent are doubled ,  find the new
average.average.

A nsA ns 1. 30
2. 102
3. 15
4. 51

Q .1 0 0Q .1 0 0 A  man s el ls  a  mobi le phone for  ₹60 0  and los es  s ome money .  I f  he had s o ld  it  for  ₹1 1 2 0 ,  his  gain would  have been 4A  man s el ls  a  mobi le phone for  ₹60 0  and los es  s ome money .  I f  he had s o ld  it  for  ₹1 1 2 0 ,  his  gain would  have been 4
t imes  the ear l ier  los s .  The c os t  pr ice ( in ₹)  of  the mobi le phone is :t imes  the ear l ier  los s .  The c os t  pr ice ( in ₹)  of  the mobi le phone is :

A nsA ns 1. 724
2. 684
3. 704
4. 734
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